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1 Introduction 

1.1 Purpose of this document 

This document describes how to use the bCRM application graphical user interface. It is intended 
for all end users of the system. Users are encouraged to read the 1995 [Goodman] paper and the 
original bCRM paper [Braun] before using the bCRM application. 

1.2 Scope of this document 

This guide only describes using the bCRM graphical interface and the bCRM facilities accessible 
via that interface for running a trial; it does not cover all the statistical details of the model and 
method that it uses for dose allocation and simulation. 

1.3 Context of this Issue  

This issue documents version 1.0.1 of the system. 

1.4 Definition of Terms  

bCRM refers to the computer programs that implement the bivariate continual 
reassessment method dose-finding algorithm, simulate and run phase 1 
clinical trials using the bivariate continual reassessment method design and 
provide charts and graphs of the results. 

A Simulation Series is comprised of a ‘Design’ for a trial using the bCRM algorithm, a set of one 
or more ‘Scenarios’ – possible probabilities of toxicities and efficacies – and 
one or more ‘Variants’ where some of the Design parameters can be varied 
to explore the effect of the variation on the operating characteristics of a 
Trial. A Simulation Series creates a number of Runs = (number of 
Scenarios) * (number of Variants). 

A Design is a set of parameters that define a trial design to be carried out using the 
bCRM algorithm. This consists of: the specific drug dose strengths that can 
be used during the trial; the ‘alpha’ value of the modelling logistic curve 
along with a set of estimated toxicity and efficacy probabilities which are 
used to define the set of curves to model the response; the start dose and 
maximum dose level increment allowed during the trial; and the trial size 
details – the number of subjects assigned in each cohort used in the trial, the 
maximum number of subjects and the trial termination conditions. 

A Scenario is a set of fixed values of the probability of toxicity and efficacy for each of 
the dose strengths to be used in the trial. These define the ‘true’ drug 
response during a simulation. 

A Variant is a small modification to a Design – for example a different cohort size, 
study sample size or value of alpha. 

A Run A run is a set of all the parameters required to simulate a trial, it is the 
combination of a Design and a Scenario. A Simulation Series creates one or 
more runs. Each run is organised as a separate folder, all the parameters for 
a run are held in a single file called ‘init.bcrm’ and all the outputs for the 
simulations of the run are held in the folder in ‘.csv’ files. (Plain text files with 
one record per line, individual values separated by commas – this format of 
file is readily imported into many other programs such as Excel, Access, 
SAS and Oracle). bCRM can have at most one run directory open at any one 
time and it is the files in this directory that provide the source data for the 
parameter values and visualisation. 
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Simulation A simulation is the result of probabilistically generating a single clinical trial 
using bCRM. bCRM creates data for subjects and their responses by 
randomly selecting from the relevant probability distributions of the scenario 
defined in the bCRM input file. A particular run may be simulated a number 
of times, indeed to accurately analyse the characteristics of a particular 
Design it must be simulated usually ~10,000 times over a range of 
scenarios. 

Trial A trial is a real clinical trial, where the user enters subjects’ data and 
responses. The bCRM Algorithm is run to determine the doses to allocate 
and to analyse the results. This facility allows bCRM’s adaptive allocation to 
be used on small (single centre) trials. 

MTD The maximum tolerable dose. This is the strongest of the doses in the trial 
that has a toxicity below the target toxicity. 

MED The minimum efficacious dose. This is the weakest of the doses in the trial 
that has an efficacy below the target efficacy. 
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2 Quick Guide 

2.1 Starting bCRM 

To start bCRM, double-click the bCRM icon that is installed on your computer desktop.   

After bCRM has started, the main window will be displayed. 

2.2 Main Window 

The main window is displayed after bCRM has started and is present until bCRM exits. It is used to 
open and create designs and to access other parts of the application. 

 

 

 

Initially the only enabled buttons are: 

 

 

 

 

 

These commands are also available from the File menu. 

2.3 Exiting bCRM 

To exit bCRM, select Exit from the File menu of the main window.  

Open existing bCRM data 

Create new Simulation Series 
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2.4 Displaying Existing Data 

To display existing bCRM Data, select Open from the File menu, click the tool button  or press 

the ctrl-o key. If there are currently any open parameter wizard, run manager, Desktop bCRM or 

visualisation windows, you will be notified that they will be closed before changing the current 
simulation series and asked if you wish to proceed. 

Use the file browser to select the directory to open and then click the Open button. If you change 

your mind about opening a particular directory then click the Cancel button. As well as folders, the 
file browser displays the bCRM input (‘init.bcrm’) and output files (‘*.csv’) in each directory to help 
you locate the correct one. 

If the bCRM input files contain any invalid parameter values, then you will be notified via a 
message box. These values must be corrected in bCRM before bCRM can be run with this design. 

 

 

In the folder selected for opening bCRM will display all its folders that contain bCRM data: 
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2.5 The Toolbar 

Once a simulation series has been created, or a pre-existing one has been opened, the 
application’s main panel becomes more interesting: 

 

 

 

 

 

 

 

 

 

 

 

 

Simulation 
Series and 
Trials 

Directory containing the 
set of Simulation Series & 
Trials 

Summary data from 
simulations or actual 
trial 

A Trial being run by bCRM 

A Simulation Series 

The design variants of the simulation series 

The scenarios of design variant 
“ThreeInCohort”, all variants are 
simulated over the same scenarios. 

The currently selected series 

Levels can be expanded or hidden by clicking 
on the ‘+’ or ‘-‘ boxes. 
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Select a simulation series or trial by clicking on its name – the line becomes highlighted. More of 
the bCRM Toolbar buttons become enabled:  

 

  

 

 

All of these operations are also available from the application’s menus. 

Right clicking on a Trial or Simulation Series selects it and opens a pop-up menu: 

 

This gives short cuts to commands described elsewhere – it also allows the simulation series (the 
simulation series directory) to be renamed or deleted. 

 

 

Open a Different Folder 
 

Launch Graph 
Manager 

Save Simulation 
Summary to File 

New Simulation 
Series 

Edit Summary 
Columns 

View 
Simulation 
Data 

Enter Trial 
Data 

Edit the 
Simulation 
Series 

Convert a variant 
or scenario to a 
trial 
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3 Creating A Trial 

A trial design should be simulated before it is run for real, to check that the operating 
characteristics of the trial will be acceptable, see [SUG-S] for the facilities in bCRM to support this 
activity. 

At the end of the simulation activity you have a chosen trial design that will be part of a Simulation 
Series – this will either be one of the variants in the series or the sole, ‘default’, version of the trial 
design in that series. To create a trial, simply select this variant in the main screen and click on the 

‘Convert row to a trial’ on the toolbar ( ). 

  

Select a ‘variant’ by clicking on its name. 

You will then be presented with the standard ‘save dialog’:  

 

This allows you to enter a name for a new directory where the trial definition and the subsequent 
trial data is to be stored. 
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Having created the trial you can check, and modify the design by right clicking on the trial name in 
the main screen and selecting ‘Edit’ from the pop-up menu. 
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4 Trial Manager 

bCRM provides a facility to manage a trial, with subject data and observed toxicities and responses 
entered manually.  The dose allocation is controlled by the bCRM algorithm. 

To open the Trial Manager, click the Manage Trial button ( ), or select Manage Trial from the 

Edit menu (Ctrl-t).  These controls are enabled only when a trial row is selected in the summary 

table. 

Each time the trial management window is opened, a dialog is displayed requesting a user name.  
This name must not contain space, comma or single quote characters.  Clicking Cancel aborts 
the operation and returns control to the main application window. There is no checking on the 
name, it is used in the audit log to record who made changes/entered data. 

 

The main Trial Manager window is then displayed. 

This is divided into a number of areas: 

• general controls for navigating the already entered subject data, 

• cohort table that lists all the subjects in the trial,  

• a panel displaying information about the currently selected cohort, 

• controls to manage a trial. 

 

 

 

To select existing cohorts in the trial, the |<, <, > and >| navigation buttons may be used or a 
Cohort ID number may be typed into the Cohort text box.  Alternatively double clicking a row in the 
cohort table displays that cohort’s details.  The currently selected cohort is highlighted in pink. 

Trail management is divided into 3 steps: 
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• creation of cohorts and the allocation of doses 

• input of observed toxicities 

• display of the recommended MTD and MED doses for further study. 

 

4.1.1 Creation of cohorts and the allocation of doses 

The Add New Cohort button creates a new cohort of subjects and executes the bCRM model to 
recommend a dose to assign them.  : 

When the calculation finishes the recommended dose strength for this cohort to be allocated is 
displayed: 

 

 

Click OK to set the cohort Drug Dose to this value, otherwise click Cancel to ignore the 
recommendation – the new cohort will be set to the first dose strength. 

If there is a cohort that has subjects with an ‘unset’ observed toxicity or response (efficacy) a 
warning dialog is displayed and a new cohort may not be added:  

 

The value in the Drug Dose field should be selected manually if the recommended dose is ignored. 

The ID is a unique number to identify the subject.  If the value entered has been repeated a 
warning is displayed and the value reset.  Each subject is automatically assigned an ID one larger 
than the current maximum, although this may be overridden. 

There is a second Ident field that may be used to provide something that further identifies the 
subject (e.g. initials, DoB, patient number). These cannot contain spaces, commas or single 
quotes. 

The table lists the subjects associated with the current cohort: 
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The admission date defaults to the current date.  The bCRM algorithm is not time dependent and 
this field is provided simply to assist cross-checking with subject data recorded elsewhere. 

To edit the date or time, click the cell in the table to display a date picker control: 

 

The required time may be set by either typing a new value into the control or selecting the hours or 
minutes component and changing it with the up and down arrows at the side of the control.   

The required date may be selected picking the month from the drop down list, selecting the year, 
either by typing a value into the control or using the up and down controls.  Clicking on a day 
button closes the control.  

The Save Data button writes the current trial subjects to a subject.csv data file.  The cohort panel is 
locked to prevent subject data being edited. Cancel locks the record and resets the data to the 
unedited values.   

Click the Edit Cohort button to switch the panel into edit mode. 

Delete Cohort permanently deletes the currently displayed subject from the trial.  A confirmation 
dialog is displayed to ensure subjects are not deleted in error. 
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4.1.2 Input of observed toxicities and responses 

To enter toxicity results, select the cohort in the cohort table. Initially all the data is locked. 

Pressing the Enter Observed Toxicities / Responses button unlocks the ‘Toxic’ and ‘Response’ 
columns of the current cohort to allow the observed toxicity or response results to be entered.  The 
remaining controls on the panel remain locked. Alternatively, pressing the Edit Cohort button 
unlocks all controls on the panel. 

Clicking a cell in the ‘Toxic’ column reveals a list of three values that may be set.  If no observed 
toxic responses are available for a subject the value should be ‘Unset’; such subjects are ignored 
when dose recommendations are made.  If a toxic event has been observed the toxicity should be 
set to ‘Toxic’, if no toxic event was observed it should be set to ‘Not Toxic’. 

 

Clicking on cells in the ‘Response’ column gives a similar set of choices, entitled ‘Unset’, 
‘Response’ and ‘No Response’ to mark whether or not efficacy has been observed. 

The Save Data button writes the updated trial subjects data to a subject.csv data file and the 
cohort panel is locked to prevent subject data being edited. If the information from the cohort 
causes the trial early termination conditions to be met, then a message will be displayed to indicate 
that the trial should now be considered complete. 

Once toxicity and efficacy information is input for each subject in a cohort, a new cohort may be 
created (see above).  The Add New Cohort button is disabled once the final cohort, i.e. the cohort 
that brings the total number of subjects in the trial to the maximum study size, has been admitted to 
the trial. 

 

4.1.3 Generate Chart Data 

In order to be able to use bCRM’s charting facilities (see [SUG-S] for details), the bCRM model 
must be run on the entered trial data. To do this simply click on the Generate Chart Data button. 
After a few seconds you should see: 

 

Now when the trial is selected in the main screen, the graph manager button in the toolbar will be 
enabled and the Graph Manager command in the View menu will be enabled. The Graph Manager 
will display the subset of graphs applicable to a trial (as opposed to a simulation): 
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4.1.4 Display of the recommended trio of dose pairs for further study 

At any point during a trial, the MTD and MED doses recommended by the bCRM algorithm for a 
subsequent study, based on the current subject data, may be calculated and displayed by pressing 
the Recommended MTD / MED button.   

 

 

After the final cohort has been admitted and observed toxicity results entered, the Recommended 
MTD / MED button will calculate the final MTD and MED doses which may be studied in a 
subsequent randomized trial. 

The Close button will close the Trial Manager window and display a reminder to resave the trial 
data if necessary. 

 

4.1.5 Audit Log 

All activity is logged in a text file (TrialLog.csv) placed in the trial directory.  Each entry is tagged 
with time, date and user name. 

The columns in the log file are:  

Column Description 

Date   The date and time of the action.  

User   The user name. 
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Action  A description of the activity, one of: 

 New/Edit/Delete Cohort 

or New/Edit/Delete Subject. 

CohortID  Numeric cohort identity. 

Dose Assigned dose strength. 

SubjectID Numeric subject identity. 

Identifier  The subject identifier. 

Admission Date The Admission date of the subject. 

Year The Admission year of the subject. 

Time The Admission time of the subject. 

Toxic  The observed toxicity for the subject: ‘Toxic’, ‘Not Toxic’ or 
‘Unset’ 

Response The observed response for the subject: ‘Response’, ‘No 
Response’ or ‘Unset’ 

 

For Cohort actions the subject columns are left empty. 

 

4.2 Reviewing Trial Data 

The last MTD / MED doses to be generated, along with the associated P(toxicity) at MTD, 
P(efficacy) at MED and their uncertainties are displayed in the main application table, and as a 
single row in the simulation data table. 
 
 


